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Цветные графические сенсорные  
дисплейные модули Nextion  
на основе микроконтроллера серии STM32

Создание современных пультов оператора на базе микропроцессорных 
устройств невозможно без использования различных типов дисплеев. 
Наиболее информативные из них – графические. В статье описываются 
цветные графические сенсорные дисплейные модули Nextion на основе 
микроконтроллера серии STM32, предназначенные для создания 
человеко-машинного интерфейса, а также представлен пример готового 
проекта.

Олег Вальпа (sandh@narod.ru)

Введение 
Для создания микропроцессорных 

пультов операторов можно исполь-

зовать различные виды дисплеев. Для 

самых простых устройств подойдёт 

7-сегментный индикатор или символь-

ный ЖК-дисплей, а для вывода про-

стейшей монохромной графики мож-

но использовать дисплеи от мобильных 

телефонов либо современные OLED-

дисплеи. Ресурсов многих микрокон-

троллеров обычно хватает для подклю-

чения и обслуживания даже цветных 

дисплеев с TFT-матрицей. Однако чем 

сложнее дисплей, тем труднее прихо-

дится микроконтроллеру. Например, 

несмотря на самые изощрённые и 

быстрые библиотеки, ресурсов микро-

контроллера Atmega328 едва хватает 

для работы с цветной TFT-матрицей. 

При этом для программы основного 

алгоритма остаётся менее половины 

памяти программ контроллера. Выход 

из ситуации заключается в том, чтобы 

наделить графический дисплей соб-

ственным микроконтроллером, кото-

рый бы использовал все свои вычис-

лительные ресурсы на обработку гра-

фики. Этот модуль можно было бы 

подключить к любому микроконтрол-

леру по одному из стандартных интер-

фейсов и обмениваться с ним унифи-

цированными командами. Именно 

такой модуль рассмотрен в этой ста-

тье – графический модуль Nextion. Дан-

ные устройства могут использоваться в 

проектах «умного» дома и других систе-

мах управления и мониторинга.

Обзор модулей Nextion

Модули Nextion [1] представляют 

собой устройства, предназначенные 

для организации современных интер-

фейсов пользователя, насыщенных 

красками и графикой. Они имеют в 

своём составе цветной графический 

сенсорный TFT-дисплей и современ-

ный 32-разрядный микроконтроллер 

серии STM32 [2], оснащённый памятью, 

слотом карт памяти microSD и внеш-

ними интерфейсами. Микроконтрол-

лер модуля предназначен для управле-

ния дисплеем и организации обмена с 

внешними устройствами. Он позволя-

ет подключать модуль Nextion к любо-

му внешнему контроллеру управления 

по последовательному интерфейсу свя-

зи UART, а также внешние кнопки, све-

тодиоды, реле и т.п. непосредственно к 

выводам GPIO модуля через согласую-

щие элементы. Модуль Nextion можно 

легко адаптировать к существующим 

проектам: для этого потребуется всего 

один выделенный порт UART у подклю-

чаемого устройства.

Первоначально производителем 

была разработана линейка базовых 

модулей Nextion Basic с диагоналями 

дисплея от 2,4 до 7″. Вскоре свет увиде-

ла линейка новой, улучшенной версии 

модулей Nextion Enhanced, имеющих в 

своём составе часы реального време-

ни RTC с автономным питанием, порты 

GPIO, память EEPROM и возможность 

формировать сигналы ШИМ. Техни-

ческие характеристики обеих версий 

модулей Nextion приведены в таблице.

Внешний вид модуля показан на 

рисунке 1.

Модуль потребляет ток около 500 мА 

от источника с постоянным стабилизи-

рованным напряжением 5 В. Яркость 

дисплея можно регулировать в диапа-

зоне от 0 до 180 единиц с интервалом 

в 1%. Стоимость модулей составляет 

от $15 до $60 в зависимости от разме-

ра дисплея. В комплект поставки входят 

модуль Nextion, плата питания с разъё-

мом Micro USB, кабель питания и связи.

Производитель разместил на сво-

ём сайте [3] бесплатные файлы для 

изготовления корпусных рамок ко 

всем типам модулей с помощью 

Функциональное назначение выводов TS1000T, VS1000

Параметры NX3224T024 NX3224T070 NX3224K028 NX4024K032 NX8048K050

Диагональ дисплея, дюймов 2,4 7 2,8 3,2 5

Разрешение экрана 320×240 320×240 320×240 400×240 800×480

Размер модуля, мм 74,4×42,9 181×108 85×49,8 95×47,6 133×84

FLASH-память, Мбайт 4 16 16 16 32

ОЗУ, Кбайт 3,5 3,5 3,5 3,5 8

Частота контроллера, МГц 48 48 48 48 108

Потребляемый ток, мА до 90 до 500 до 65 до 85 до 410

Линейный ряд Basic Enhanced

Выводы GPIO Нет 8 выводов, из них 4–7 поддерживают ШИМ

Часы реального времени Нет Есть, с элементом питания типа CR1220

Напряжение питания 5 В постоянного тока 500 мА

Тип подсветки экрана Светодиодная подсветка с регулируемой яркостью

Тип сенсорного экрана Резистивный

Количество цветов 65 536 в коде 5R6G5B

UART Скорость от 2400 до 115 200 (по умолчанию 9600), уровни TTL

Тип SD-карт microSD объёмом до 32 Гбайт c файловой системой FAT32

Рабочая температура –20…+70°C

Температура хранения –30…+85°C
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3D-принтера. Кроме того, на сайте име-

ются свободно распространяемые гото-

вые демонстрационные проекты для 

любого модуля.

Программное обеспечение

Инженеры подчас тратят много вре-

мени, разрабатывая интерфейсы для 

уникальных пультов, но при этом не 

всегда получают удовлетворительные 

результаты. В качестве решения этой 

проблемы создан бесплатный про-

граммный редактор Nextion Editor [4], 

который имеет встроенные компонен-

ты, позволяющие создавать дизайн 

интерфейса: текст, кнопки, слайдеры, 

картинки, графики, прогресс-бары, 

панели приборов и т.д. Кроме того, он 

позволяет создать алгоритм поведе-

ния модуля с помощью программного 

кода для различных событий элемен-

тов, участвующих в интерфейсе дис-

плея. Для проверки работы написанно-

го программного кода в редакторе име-

ется встроенный эмулятор, не только 

отображающий поведение элементов 

интерфейса, но и полноценно работа-

ющий с данными по интерфейсу UART, 

посредством которого в модуль Nextion 

загружаются программы.

Для ускоренной загрузки програм-

му можно разместить на карте памя-

ти, которую затем следует установить 

в слот microSD модуля Nextion.

Пример проекта

Рассмотрим работу с программой 

Nextion Editor на простом примере. 

Пусть новое приложение будет состо-

ять из трёх страниц: начальной с назва-

нием проекта, главной с элементами 

индикации и управления и дополни-

тельной со справочной информацией. 

Для создания проекта интерфейса 

потребуется загрузить с официально-

го сайта производителя [4] програм-

му Nextion Editor и разархивировать 

её на компьютер. Установки эта про-

грамма не требует. После запуска фай-

ла NextionEditor.exe на экране компью-

тера откроется главное окно редакто-

ра, показанное на рисунке 2.

Окно имеет 9 зон:

1.	Главное меню – File, Tools, Setting, 
Help, About.

2.	 Библиотека элементов – Toolbox.
3.	 Библиотека изображений и шриф-

тов – Picture, Fonts.

4.	 Область отображения – Display.

5.	 Список страниц проекта – Page.

6.	 Зона редактирования атрибутов вы-

бранного элемента – Event.
7.	 Окно вывода результатов компиля-

ции – Output.
8.	 Окно для ввода кода, выполняемого 

при возникновении события – User 
code.

9.	 Меню управления выравниванием 

и порядком элементов – под глав-

ным меню.

Для первого знакомства с програм-

мой Nextion Editor наибольший инте-

рес представляет окно библиотеки эле-

ментов. В нём содержатся элементы, 

которые можно размещать на экране 

дисплея:

●● Text – текстовое поле;

●● Scrolling text – текстовое поле с про-

круткой (бегущая строка);

●● Number – поле с числовыми значе-

ниями;

●● Button – кнопка без фиксации;

●● Dual-state button – кнопка с фиксацией;

●● Hotspot – невидимая кнопка;

●● Progress bar – область, заполненная 

на заданное значение в %;

●● Picture – изображение, выбранное из 

списка загруженных файлов;

●● Crop – часть изображения;

●● Gauge – стрелка;

●● Waveform – поле построения графи-

ка по точкам;

●● Slider – слайдер, т.е. область с пере-

двигаемым ползунком;

●● Timer – таймер; вызывает событие че-

рез определённые промежутки вре-

мени и размещается под областью 

Display;

●● Variable – переменная для хранения 

данных, размещается под областью 

Display;

●● Checkbox – флажок поля множествен-

ного выбора;

●● Radio – переключатель поля одиноч-

ного выбора.

а б

Рис. 1. Внешний вид модуля Nextion: а) со стороны дисплея; б) со стороны компонентов

Рис. 2. Главное окно редактора Nextion Editor
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Для создания нового проекта следу-

ет выбрать в главном меню редактора 

команду File → New – при этом откроет-

ся окно с запросом имени проекта. Про-

екты создаются с расширением *HMI. 

После ввода имени проекта откроется 

окно настроек Setting для выбора типа 

панели (см. рис. 3).

В этом окне приведены назва-

ния типов панелей с их техниче-

скими характеристиками. Напри-

мер, при выборе панели Enhanced 

NX4827K043_011 можно увидеть, что 

она имеет дисплей 4,3″ с разрешени-

ем 480×272 точки, объём памяти Flash 

32 Mбайт, объём оперативной памя-

ти RAM 8192 байт и тактовую частоту 

108 МГц. Выбранный тип панели авто-

матически выделяется цветом. Закладка 

DISPLAY окна настройки Setting позво-

ляет выбрать горизонтальную, верти-

кальную или повёрнутую ориентацию 

дисплея модуля, а также тип кодиров-

ки для текстовых элементов. Повторно 

открыть окно настроек Setting можно в 

любое время нажатием программной 

кнопки Device в главном меню редак-

тора.

После завершения выбора панели и 

её настроек откроется окно с началь-

ной страницей для наполнения её 

библиотечными элементами и ввода 

программного кода обработки. Прежде 

чем начать наполнять страницу элемен-

тами, следует добавить используемые в 

проекте шрифты и рисунки в соответ-

ствующее окно Font/Picture редактора 

с помощью программной кнопки «+».

Шрифты можно сконвертировать 

из имеющихся шрифтов операцион-

ной системы с помощью встроенного 

в редактор программного инструмен-

та Tools → Font Creator, окно которого 

показано на рисунке 4. 

После выбора исходного шрифта и 

задания размера нового можно сфор-

мировать шрифт и автоматически доба-

вить его в редактор.

Для создания файлов с рисунками 

подойдёт любой графический редак-

тор, входящий в состав операционной 

системы, например Paint. С помощью 

такого редактора можно создать рису-

нок для начальной страницы размера-

ми 480×272 точки, залив его сплошным 

цветом, дополнив простыми фигура-

ми и введя текст с названием, напри-

мер как на рисунке 5.

Аналогично можно создать рисун-

ки для органов индикации и управле-

ния, такие как светящаяся и погашен-

ная лампочка, зелёный и красный круг 

для отображения состояния охраны 

и т.п. Рисунки должны иметь размеры, 

позволяющие разместить их на страни-

це и внутри используемых элементов, 

например 50×50 точек. Все созданные 

изображения необходимо добавить в 

редактор для последующего использо-

вания в проекте.

Для размещения рисунка на странице 

page0 необходимо изменить в редакто-

ре свойство sta этой страницы на image 

и с помощью появившегося свойства 

pic выбрать рисунок с названием про-

екта в открывшемся окне Select Picture, 

представленном на рисунке 6.

Теперь необходимо добавить в про-

ект ещё две страницы с помощью пер-

вой программной кнопки окна Page 

редактора. Новые страницы автомати-

чески получат названия page1 и page2. 

При выборе их мышкой редактор авто-

матически будет открывать эти страни-

цы в центре экрана.

Для завершения работы с первой 

страницей нужно выделить её и доба-

вить для неё новый элемент Timer из 

окна Toolbox. Свойству tim этого тай-

мера следует задать время отобра-

жения начальной страницы, напри-

мер 1000 мс. Для перехода на главную 

страницу через 1000 мс нужно в окне 

событий Event ввести команду перехо-

да в виде строки page1. Теперь мож-

но проверить работу программы в 

отладчике Debug, щёлкнув мышкой 

по соответствующей кнопке интер-

фейса редактора, и убедиться, что 

при запуске программы открывается 

начальное окно с рисунком названия 

проекта, а через секунду происходит 

переключение на главное, пока ещё 

пустое окно.

Следующим шагом следует запол-

нить страницу справки page2, разме-

Рис. 3. Окно настроек Setting Рис. 4. Окно создания шрифтов

Рис. 5. Окно начальной страницы проекта

Рис. 6. Окно Select Picture редактора
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Анализ состояния охраны осущест-

вляется с помощью кода, внесённого в 

поле событий таймера tm0 начальной 

страницы:

Выполнение операций управления 

дверью и освещением обеспечивает 

код в поле событий для соответству-

ющих элементов окна главной стра-

ницы:

При нажатии кнопок пульта главной 

страницы модуль Nextion будет форми-

ровать сообщения через порт UART бла-

годаря командам в поле событий для 

соответствующих элементов кнопок 

окна главной страницы. Например, для 

кнопки «2» применена строка коман-

ды printh 32.

Полная версия проекта представле-

на в дополнительных материалах к ста-

тье на сайте журнала www.soel.ru. При 

желании этот проект можно допол-

нить новыми элементами управления 

и индикации.

Перед загрузкой в модуль необхо-

димо скомпилировать проект, нажав 

кнопку Compile в интерфейсе редак-

тора. В окне вывода результатов 

должно отобразиться сообщение об 

успешной компиляции или о нали-

чии ошибок, которые необходимо 

исправить.

Для загрузки проекта с компью-

тера в модуль Nextion через порт 

UART понадобится преобразователь 

USB-UART. После подключения пре-

образователя к модулю необходи-

мо нажать кнопку Upload. Процесс 

загрузки проекта будет отображать-

ся в окне программного редактора и 

на дисплее модуля. После окончания 

загрузки проект автоматически нач-

нёт выполняться и отображаться на 

дисплее модуля.

Поскольку загрузка проекта через 

порт UART занимает достаточно дол-

гое время и требует дополнительно-

го оборудования в виде преобразова-

стив на ней бегущую строку Scrolling 

text с информацией и кнопку Button для 

возврата на главную страницу. Эти эле-

менты находятся в окне Toolbox. Свой-

ство длины строки txt_maxl для Scrolling 
text необходимо задать максимально 

возможным и равным 254. Справоч-

ную информацию следует ввести в 

свойство txt элемента бегущей строки 

Scrolling в виде текста. Положение и раз-

меры строки легко изменяются с помо-

щью мышки.

Для элемента Button нужно изменить 

свойство txt на название «Назад» и вве-

сти в поле событий Event команду пере-

хода на главную страницу в виде стро-

ки page1.

Наконец, нужно наполнить элемен-

тами главную страницу page1. Внача-

ле следует разместить на ней элемент 

кнопки Button и изменить его свойство 

txt на слово «Справка». В окне событий 

Event для этой кнопки следует ввести 

команду перехода на созданную ранее 

справочную страницу в виде строки 

page2.

Для отображения на главной страни-

це текущего времени следует поместить 

на ней три элемента Number и элемент 

таймера Timer. В поле свойств таймера 

следует ввести три строки для передачи 

данных из внутренних часов реально-

го времени в свойства Valume элемен-

тов Number в виде строк n0.val=rtc3, 
n1.val=rtc4 и n2.val=rtc5. Стоит учиты-

вать, что редактор довольно требовате-

лен к синтаксису и не допускает лиш-

них пробелов в строках команд. 

Цвет и фон отображаемых цифр 

времени можно изменить с помощью 

свойств bco и pco элементов Number.

Далее следует разместить на главной 

странице проекта ещё несколько эле-

ментов в соответствии с рисунком 2 – 

с их помощью можно будет контроли-

ровать охранную систему, управлять 

открытием и закрытием двери, вклю-

чать и отключать освещение, а также 

эмулировать простой пульт с индика-

тором и кнопками управления.

Для связи модуля с контролируемым 

объектом будут использованы порты 

ввода-вывода GPIO и последователь-

ный порт UART. Инициализация пор-

тов GPIO производится в поле событий 

начальной страницы:

// Настроить порт GPIO

cfgpio 1,2,0 // Вывод pio1 - вы-

ход

cfgpio 2,2,0 // Вывод pio2 – вы-

ход

// Охрана

if(pio0==0) // Если норма

{

 p0.pic=1 // Зеленый

}else // Иначе

{

 p0.pic=2 // Красный

}

// Дверь

pio1=bt1.val // 0-закрыть 1-от-

крыть

// Свет

pio2=bt2.val // 0-отключить 

1-включить

теля, существует альтернативный спо-

соб загрузки проекта с помощью карты 

памяти microSD. Для этого нужно ском-

пилировать проект и открыть каталог с 

файлом загрузки при помощи главно-

го меню File → Open builder folder. Далее 

следует скопировать файл загрузки с 

именем созданного проекта на пред-

варительно отформатированную в 

FAT32 карту памяти microSD. На ней 

должен находиться только один файл 

проекта. Затем нужно установить кар-

ту памяти в слот отключённого модуля 

Nextion и включить его – при этом нач-

нётся быстрый процесс загрузки про-

екта в модуль.

Внешний контроллер управления, 

подключённый к модулю Nextion 

через порт UART, может формировать 

командные строки. Например, для ото-

бражения текста на индикаторе моду-

ля используется строка следующе-

го вида: page1,t4.txt="Произвольный 

текст...\0xff\0xff\0xff".

Все внешние команды по интерфейсу 

UART для модуля Nextion должны завер-

шаться тремя байтами cо значением 

255, т.е. 0xff в HEX-коде. Это позволя-

ет модулю Nextion идентифицировать 

посылку как команду и определить её 

окончание.

Кроме того, внешний контрол-

лер может формировать любые дру-

гие команды, применяемые в модуле 

Nextion, а также принимать и анализи-

ровать информацию от модуля, напри-

мер коды кнопок встроенного в проект 

эмулятора пульта.

Модуль Nextion имеет достаточно 

большой набор команд, подробное 

описание которых приведено в источ-

нике [5]. 

Заключение

Благодаря существованию недорогих 

модулей Nextion и свободного редак-

тора программ создание современных 

и привлекательных человеко-машин-

ных интерфейсов становится простым 

и увлекательным делом, доступным как 

профессионалам, так и начинающим 

программистам.
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«Силовая Электроника 2019»: 
открыт приём заявок  
на участие в конкурсе

Начался приём заявок на участие в кон-

курсе «Лучшие разработки молодых иссле-

дователей и инженеров в области силовой 

электроники», который традиционно прой-

дёт в рамках выставки «Силовая электро-

ника».

Конкурс призван продемонстрировать ре-

зультаты инновационной деятельности мо-

лодых исследователей и инженеров, име-

ющих учёную степень или не имеющих та-

ковой, работающих в штате университета, 

государственного промышленного предпри-

ятия, закрытого или открытого промышлен-

ного акционерного общества, которым в год 

проведения конкурса исполнилось не бо-

лее 35 лет.

 Номинации конкурса:

●● Силовая электроника и системы управ-

ления для электропривода и других элек-

тромеханических систем.

●● Электронные системы автономных объектов 

и для малой распределённой энергетики.

●● Источники вторичного электропитания 

и преобразователи с высокой удельной 

мощностью.

●● Современные элементная база, пассив-

ные компоненты и накопители энергии.

Организаторы: компания MVK (офис в 

Санкт-Петербурге) и Национальный ис-

следовательский университет «МЭИ» при 

поддержке Департамента радиоэлектрон-

ной промышленности Министерства про-

мышленности и торговли Российской Фе-

дерации и ассоциации «Электропитание».

По вопросам участия следует обращаться 

по номеру телефона (812) 380-60-09 или по 

адресу электронной почты power@mvk.ru.

www.powerelectronics.ru

Нормативная база  
для легализации eSIM  
в России будет готова  
в 2019 году

Минкомсвязь планирует подготовить нор-

мативную базу для внедрения технологии 

электронных сим-карт eSIM в России к кон-

цу 2019 года. 

Использование eSIM в России не тре-

бует внесения изменений в законодатель-

ство, считают в Минкомсвязи. В справке, 

подготовленной ведомством, отмечается, 

что eSIM представляет собой такой же мо-

дуль идентификации абонента, как и обыч-

ная сим-карта. Для того чтобы устройство с 

ним могло работать в российских сотовых 

сетях, будет достаточно декларации соот-

ветствия аппарата российским требовани-

ям использования средств связи.

В настоящее время использование eSIM 

запрещено в России на законодательном 

уровне. Электронные SIM-карты легализо-

ваны и функционируют в ряде стран ЕС, Ка-

наде, США и Индии.

Новости Интернета вещей
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